
WordStar for Windows 2.0 README

This document contains technical tips for using WordStar for Windows (WSWin) and information 
that was unavailable when the manual went to print.

Choose Print from the File menu to print this document.
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1.  On-line Help and User's Guide

The best place to find in-depth, step-by-step information on any feature is in the on-line Help.     

TIP   While you're running WSWin Help, you can select Always on Top from the Help menu.  If 
you adjust the Help window size to fill half your screen or less, you can follow the instructions 
while working on your document.

User's Guide Correction 
Pp. 90 and 91.  The Spacing Outside should be on the other side of  the 2-point line in both 
drawings.
                   

2.  Setup

Running Setup
If you have trouble running Setup, follow one or more of the following suggestions: 

-    Run Setup again.
-    Try using a different disk drive.
-    Make sure you have a TEMP variable in your AUTOEXEC.BAT file set to an existing
    drive and directory (SET TEMP=C:\TEMP).
-    Close any other applications running at the same time as Setup.
-    Create a 4MB (minimum) swap file.
-    Make sure the PATH command in your AUTOEXEC.BAT is correct and that it includes 
    the disk drive for each entry. For example, use C:\WINDOWS instead of  \WINDOWS. 
-    Try a test install on another computer if you have one available. 

TIP   Be sure to include the backslash when you specify the Install Destination Drive, i.e., C:
\WSWIN and not C:WSWIN.  Otherwise, Setup uses the current logged directory.
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Disk Space 
If Setup reports that you don't have enough disk space to install WSWin, but you're confident that 
you do, check to see if you have some temporary files that you can delete.   

WSWin creates temporary files in the directory defined by the TEMP environment variable or the 
WSWWORK environment variable. If you exit WSWin in a non-standard way, by rebooting the 
computer, for example, WSWin cannot delete its temporary files. 

To avoid accidentally deleting files in use by other Windows applications, exit Windows before 
deleting temporary files.  WSWin's temporary files begin with ! or ~ or use the extension TMP.

Installing over WSWin 1.5
If you haven't enough free disk space to run Setup, you can remove the contents of the WSWin 
1.5 main directory.  (To be safe, first double-check to make sure you have no valuable .WSD files 
in this directory.)                                                   

After a Complete Install over WSWin 1.5, you may have two copies of Correct Grammar on your 
hard disk.  WSWin 2.0 will use the most recent one.  You can delete the old CGW directory--
unless you have another application that uses Correct Grammar.   

Performance 
Setup will run slowly if you do not use a disk cache that caches floppy disks.  We recommend that 
you use SMARTDrive 4.0 or higher with the default settings.  Or you can make sure that the line 
buffers=30 appears in your CONFIG.SYS file.

Setup might also run very slowly if it encounters an error reading floppies or writing to the hard 
disk.  In this case Windows sometimes turns off the hard-drive disk cache.  To correct this 
problem, allow Setup to finish, exit Windows, and reboot your computer.  

Macro System On-line Reference/Help
Choose Complete Install or Custom Install if you plan to work extensively with the macro system. 
If you choose Minimal Install, the Macro Help file will not be available.  

3.  Upgrading from WSWin 1.5                       
              
Menus 
Added: Macro and Window menus
Moved: Graphics and Table menus (items on these menus were moved to the Frame

menu)
Renamed: Layout now called Frame

Context menus
You can access the most commonly used features by pointing to various areas on-screen (the 
page, text, graphic, or table frames, status and style bars, etc.) and pressing the right (or 
secondary) mouse button. A context menu will display conveniently near your cursor position.

Keystrokes               
Pressing Ctrl while dragging a selected graphic object will now copy that object.  Pressing Shift 
will constrain the movement horizontally or vertically.  
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4.  Upgrading from WordStar or WordStar 2000 for DOS

Keystrokes
Several keystrokes have been added to the WordStar and WordStar 2000 keystroke sets.  If your 
favorites are still missing, you can record and save a macro for the function and assign the macro 
to an appropriate keystroke.

Key Switchers (If your keyboard does not provide key switching)
WordStar and WordStar 2000 users who wish to swap the functionality of their Ctrl and Caps 
Lock keys can do so by following the steps below.  (The Ctrl and Caps Lock keys will be switched 
for all applications.)

Note:  If installing the switch function produces unexpected results, revert to the default keyboard 
configuration.

1)  Copy SWITCH.COM to a directory listed on your DOS path.  (If you've already installed the 
    WordStar SWITCH.COM, you do not need to complete steps 1-3.)
2)  Test whether SWITCH.COM is compatible with your computer: type SWITCH at the DOS 
    prompt. A message indicates whether the switcher is installed or not supported.      
3)  If SWITCH is installed, edit AUTOEXEC.BAT and add the line SWITCH.  (Install the switcher 
    before you load any memory resident programs that use hot keys.)
4)  Copy WSWKBD.DRV (in your WSWIN directory) to your WINDOWS\SYSTEM directory.  
5)  Edit SYSTEM.INI and go to the line: 
              keyboard.drv=keyboard.drv
    Change it to read: 
              keyboard.drv=wswkbd.drv

Auto-conversion and Import
See section 10 below

5.  Printer and Display Drivers

Incorrect Printed Output
If your documents print incorrectly, the printer driver might be out of date.  You can obtain the 
latest driver from the printer manufacturer or from Microsoft forums in on-line services such as 
CompuServe, America Online, or Prodigy.  

Micrografx PostScript Printer Driver
WSWin 2.0 is not compatible with Micrografx PostScript driver versions 2.81 and earlier.  Use the 
Postscript driver that comes with your Windows software or the PostScript driver provided with 
your particular printer. 

Display Problems 
If  the display of text and graphics on the screen differs significantly from your printed output, you 
may need to update your display drivers.  Contact the display card manufacturer or check for 
updates on CompuServe.
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6.  Error Conditions   
                              
If you encounter a message that allows you to choose Close or Ignore, we suggest that you 
choose Ignore, save your document and continue working.  WSWin will usually correct the error.  
If you choose Close, you won't have an opportunity to save your work.

If you encounter an Application Error when running any program under Windows, it is best to exit 
to DOS and restart Windows to reset the memory in your computer. 

7.  Importing Graphics

Notes  
Choose the correct import file type when importing graphics.  For example, when importing PCX 
files, be sure to choose the PCX: ZSoft Paintbrush filter listed in the Import dialog box.     

Some large 24 bit images might take several minutes to import. 

Filters 
BMP, DIB  Bitmap
CGM  Computer Graphics Metafile
DRW  Micrografx Designer
GIF Graphics Interchange Format
PCX  ZSoft Paintbrush
PIC  Lotus 1-2-3 Picture
PIX  Inset
TIF  Tagged Image File Format
WMF  Windows Metafile

8.  Correct Grammar

Checking grammar in a document that contains floating frames may cause those frames to 
become fixed.  You can check the document in sections to avoid this problem.

Footnotes must be at least two lines long in order to be checked by Correct Grammar.  Also, 
footnotes with more than 1,000 characters might cause style tags to display in Correct Grammar. 
For example,  ;@BodyText may appear on a separate line in the Correct Grammar window.       
You can delete these tags.

9.  MailList

.DBF Files
The files in the \MAILDATA directory are not standard WSWin files; don't try to open them in 
WSWin. You can open the .DBF files in the MailList program. Files with an extension starting with 
X are index files for the databases. 

MailList and Printer Drivers
Your printer might not be capable of printing all layouts available in MailList.  For example, some 
printers have only one envelope choice: #10 4 1/8" x 9 1/2".  Other envelopes might not print 
correctly on such printers. Press the Print Setup button on the Print dialog box to see what 
choices your printer has available. 
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Landscape Printing 
For those labels that require landscape printing, press the Print Setup button on the Print dialog 
and select landscape.  Be sure the paper source and paper size are also what you want.

10.  Auto-conversion and Import of Text

Auto-converting versus Importing
When you choose Open from the File menu and select a non-WSWin document, WSWin 
automatically converts that document before opening it.  Auto-conversion provides the best 
conversion of the original document and maintains its headers or footers.

When you have a WSWin document open and you choose Import Text from the File menu, you 
are importing information from a document created in another application.  WSWin makes no 
attempt to convert features that might conflict with formatting in the open document.

Filters
You might not always know the format of a document you import or open.  You can prevent a 
serious error by selecting DOS Text as the Import Type (Import dialog box) or Available Format 
(Warning dialog box for conversions).

If WSWin does not have a filter for a specific document, you can move the information into 
WSWin by copying it to the Clipboard and then pasting it into an open WSWin document.

TIP  If you have the application in which you created the original document, you may be able to 
save it to a format supported by WSWin.  

Use DOS Text without Line Breaks to export WSWin files for desktop publishing and typesetting 
systems.  Each paragraph (wrapped text) from the WSWin document becomes a long, single line 
in the exported file.  When the exported file is opened in another program, the text formats, or 
wraps, to fit inside the new margins.

Available Filters
WSWin currently provides filters that allow you to convert, import, or export files for the 
applications below.  The asterisk (*) denotes filters that are NOT available for auto-conversion.  
Contact technical support regarding availability of other filters.

    Ami Professional 1.1, 1.2, 2.0, 3.0
    ANSI/Windows Text*
    dBASE III, III Plus, IV  v. 1.0
    DOS Text (no export)
    DOS Text with Format Tags*
    DOS Text (with/without Line Breaks--export only)
    Lotus 1-2-3 1A, 2.x (PC Char Set--no export)          
    Lotus 1-2-3 2.x (LICS Char Set--no export)          
    Lotus 1-2-3 3.x (no export)
    Microsoft Excel 2.1, 3.0, 4.0 (no export)   
    Microsoft Windows Write 3.0, 3.1
    Microsoft Word 3.0, 3.1, 4.0, 5.0, 5.5, 6.0
    Microsoft Word for Windows 1.x, 2.0
    Microsoft RTF (Rich Text Format)
    Paradox 3.5, 4.0 (no export)
    PFS: First Choice 1.0, 2.0 , 3.0
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    PFS: WRITE Version C
    Professional Write 1.0, 2.x
    Professional Write Plus
    Quattro Pro DOS 4.0 (no export)
    Quattro Pro Windows 1.0 (no export)
    Word for Word
    WordPerfect 4.1, 4.2, 5.0, 5.1, 5.2, 6.0
    WordStar 2000 3.0, 3.5
    WordStar DOS 3.3, 3.4, 4.0, 5.0, 5.5, 6.0, 7.0
    WriteNow 3.0, 4.0
    WSWin Paragraph Styles (no export)*
    WSWin Frame Styles (no export)*
    WSWin Text* (.WSX)

AUTO-CONVERTING     

Because no two applications are alike, conversion is a complicated process.  In all cases, the 
goal is to do the following:

    -    Create a converted document that is as close to the original document as possible.

    -    Require a minimum amount of cleanup on the converted document.  (Cleanup may 
         include creating or modifying styles, removing unnecessary page breaks, or adding 
         graphics.)

Auto-Conversion Conventions 
The following rules apply when you auto-convert text files from other applications:

Characters
WSWin converts most characters correctly, including non-English characters but excluding ASCII 
line-drawing characters.  If a character cannot be translated, WSWin displays an underscore 
character, or uses a character similar to the original.

Fonts
Conversion of font families varies with the application.  See the sections on WS and WS2000 
below.

Styles
Conversion of styles varies with the application.  See the sections on WS and WS2000 below.

TIP   For best results, turn off Widow Control in the converted document's paragraph styles.

Format Changes
Changes in font family, point size, or emphasis are marked by tags.

Date and Time
Date and time are converted as text.

Headers and Footers
Converted headers and footers are placed in header or footer frames and assigned the Header or 
Footer frame style.
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If Format Type Is Incorrect
If WSWin has misread the format type of the source document during auto conversion, select the 
correct format type.  If auto-conversion is still not successful, try importing the document instead 
of opening it.

Converting from WordStar for DOS
Fonts
If you're using TrueType fonts, your fonts convert as follows:

    -    Serif proportional fonts convert to Times New Roman
    -    Sans serif proportional fonts convert to Arial
    -    Nonproportional fonts convert to Courier New
    -    Characters with no font information convert to Courier New (including text assigned a 
         default font in the original WordStar document)

If the TrueType fonts are not installed, WSWin assigns fonts from a similar font family.

Styles
Style names are retained. New styles based on the BodyText style are created to handle 
instances where indents or other formats have changed.  For conversions, these new styles are 
assigned the names Convert 001, Convert 002, Convert 003, and so on.

Not Converted
    -    Line numbering (.L#)
    -    Turn page numbering back on (.PG)
    -    Overprint characters (^PH)
    -    Overprint lines (^P+Enter)
    -    Alternate font (^PA)
    -    Even and odd page offset (.POE, .POO)
    -    Conditional column break (.CC)
    -    Tab leaders (^P.)
    -    Orphan control
    -    Index entries (.IX)
    -    Table of contents entries (.TC)
    -    Insert file (.FI)
    -    Comment lines (.IG or..)
    -    Custom print controls (.XE, .XL, .XQ, .XR, .XW)
    -    Date and Time variables 
    -    Odd and even headers and footers

Needs Attention after Converting
    -    Columns - WSWin inserts markers at the beginning and end of columns.  The column 
         formatting isn't converted.  To format the columns, you can create a frame style with the 
         column settings you want and apply that style to the text.  Or you can use the Column 
         buttons in the tab/align bar.

    -    Inserted graphics - WSWin marks the location of the graphics you inserted in WordStar.  
         You can reinsert graphics files using the Import command after creating a graphics frame.   

    -    Page length (.PL) - The frame size will be converted correctly, but you may need to            
         choose Page Setup on the File menu and reset Paper Size.

    -    Paragraph numbering - WSWin converts paragraph numbers (^OZ, .P#) to text.  You can 
         choose Auto Number on the Style menu to create or modify a numbering style.  Then you 
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         can apply the style to your text.

    -    Single-spaced line height - If the space between lines makes your text look crowded, 
         change the Line Height option in the Modify Paragraph Style dialog box (Style menu).

    -    Large documents - If you see the message "Can't open source file" when converting large 
         WordStar documents, try splitting up the original document and converting it in sections.

    -    Endnotes - WSWin converts endnotes to footnotes.  To convert these footnotes back to 
         endnotes, select the Print Notes At End of Story line button in the Page Setup dialog box 
         (File menu).

Converting from WordStar 2000
Fonts
If you're using TrueType fonts, your fonts convert as follows:

    -    Serif proportional fonts convert to Times New Roman
    -    Sans serif proportional fonts convert to Arial
    -    Nonproportional fonts convert to Courier New
    -    Characters with no font information convert to Courier New (including text assigned a 
         default font in the original WordStar 2000 document)

If the TrueType fonts are not installed, WSWin assigns fonts from the same font family.

Proper Font Conversion
If you install the filter for WordStar 2000 documents, take one of the following steps to ensure the 
fonts are converted properly:

    -    In the [WSWin] section of the WSW.INI file (found in the Windows directory), add the file 
         path of any WordStar 2000 .PDF files used by your WordStar 2000 documents.  For 
         example,
              

PDFDIR=c:\ws2000\printer

    -    As an alternative, make sure the WordStar 2000 .PDF files are in the same directory as 
         the WordStar 2000 documents you plan to convert.

Not Converted 
    -    Appendix headings (TOC)
    -    Assign page number (^OA)
    -    Bypass spelling check
    -    Color (^PC)
    -    Continuous underline (^OL)
    -    Display page breaks 
    -    Figure (TOC) (^OIF)
    -    Form feeds
    -    Keep lines together (^OK)
    -    Line numbering (^PL)
    -    Merge print commands
    -    No new line (^PN)
    -    Number of lines per page (^TMP)
    -    Pause printing (^PP)
    -    Place markers (^CM)
    -    All print extras (^PX)
    -    Table (TOC) (^OIT)
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    -    Tray select
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Needs Attention after Converting 
    -    Endnotes - WSWin converts endnotes to footnotes.  To convert these footnotes back to 
         endnotes, select the Print Notes At End of Story line button in the Page Setup dialog box 
         (File menu).

    -    Large documents - If you see the message "Can't open source file" when converting large 
         WordStar 2000 documents, try splitting up the original document and converting it in 
         sections.

    -    Merged graphics - WSWin marks the location of graphics you merged in WordStar 2000.  
         You can reinsert graphics files using the Import command after you create a graphic 
         frame.   

IMPORTING

Text Import Conventions
The rules below apply when you import text files from other applications.  If you're importing from 
WordStar, see information about WS and WS2000 below.

Characters
WSWin imports most characters correctly.  If a character (including non-English characters) 
cannot be translated, it appears as a blank space in the imported text, or it uses a character 
similar to the original.

Fonts
Font families are not converted.  Imported fonts default to the fonts set by the BodyText style in 
the current WSWin document.  The size of the imported font will be as close as possible to the 
font size in the original document.

Styles
New styles are created to handle instances where indents or other formats have changed.  The 
new styles will be assigned the names Import 001, Import 002, Import 003, and so on.

Format Changes
Changes in point size or emphasis are marked by tags.
    
Date and Time
Date and time are imported as text.

Headers and Footers
Headers and footers are imported as invisible text on the page in which they were created.  They 
are assigned the style IMPORT RHC.  (You can see these imported headers and footers in the 
draft editor.)  You can transfer this text to a header or footer frame by following these steps:

    1)   Modify the paragraph style to clear the Hidden check box (Style menu, Modify Paragraph 
          Style, Character option).     
    2)   Cut and Paste the header or footer into a header or footer frame.

DOS Text with Format Tags
When ASCII formatted text is imported, WSWin interprets format tags regardless of the setting of 
the Interpret Format Tags check box.
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.WSD Files and Imports
Do NOT import .WSD files using the WSWin Text filter.  (See "Importing from WSWin" below.)  
The WSWin Text filter is reserved for files created by building a table of contents, index, or list, or 
by exporting a WSWin story line.

Import Operation
Once the import operation has begun, you cannot cancel it.

Extra Tags after Import
You may notice that extra tags appear at the beginning and end of a file after some imports.  You 
may delete them.

Importing from WSWin
Styles
Numbering style names are imported.  However, you'll have to recreate the formatting of any non-
default numbering styles.

Transferring Information Between WSWin Documents
Open both documents and use either Drag and Drop or Cut and Paste for quick results.  
However, if you want to import the information, follow these steps:

    1)   Start the export by pulling down the File menu and choosing Export Text.
    2)   In the Export dialog box, select WSWin Text in the Export File as Type box. In the
          Filename box, specify a filename (the program will supply the .WSX extension).  Then 
          choose OK .
    3)   Close the original document and open the document or template you want to use.
    4)   Start the import by pulling down the File menu and choosing Import Text.
    5)   In the Import Text dialog box, select WSWin Text.  In the Filename box, select the 
          filename you just exported (with the .WSX extension.)

Importing from WordStar

Not Imported 
    -    Column (.CO)
    -    Line numbering (.L#)
    -    Turn page numbering back on (.PG)
    -    Page numbers with #
    -    Double strike (^PD)
    -    Left and right margins (.LM, .RM)
    -    Temporary indent (^OG)
    -    Line height (.LH)
    -    Ruler lines (.RR)
    -    Even-page and odd-page headers (.HEE and .HEO)
    -    Even-page and odd-page footers (.FEE and .FEO)
    -    Even-page and odd-page page offset (.POE and .POO)
    -    Insert graphics (^P*)
    -    Tab leaders (^P.)
    -    Alternate font (^PA)
    -    Custom print controls (.XE, .XL, .XQ, .XR, .XW)

Needs attention after importing from WordStar 
    -    Endnotes - WSWin converts endnotes to footnotes.  To convert footnotes back to
         endnotes, select the Print Notes At End of Story line button in the Page Setup dialog box 
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         (File menu).

    -    Paragraph numbering - WSWin converts paragraph numbers (^OZ, .P#) to text.  You can 
         choose Auto Number on the Style menu to create or modify a numbering style.  Then you 
         can apply the style to your text.

Importing from WordStar 2000
Not Imported 
    -    Columns
    -    Line height
    -    Tab stop changes
    -    Endnotes
    -    Colors (^PC)
    -    Merged graphics (GM)
    -    Appendix heading (TOC)
    -    Assign page number (^OA)
    -    Bypass spelling check
    -    Continuous underline (^OL)
    -    Display page breaks
    -    Figure (TOC) (^OIF)
    -    Form feeds
    -    Keep lines together (^OK)
    -    MailMerge commands
    -    No new line (^PN)
    -    Number of lines per page (^TMP)
    -    Pause printing (^PP)
    -    Place markers (^CM)
    -    All print extras (^PX)
    -    Table of contents (TOC) (^OIC)
    -    Tray select
     
Needs attention after Importing from WordStar 2000 
WSWin converts endnotes to footnotes.  To convert these footnotes back to endnotes, select the 
Print Notes at End of Story line button in the Page Setup dialog box (File menu).

11.  TRADEMARK NOTICE

     The product names in this file may be trademarks or registered trademarks of their respective 
owners.
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